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What's New in R:BASE 11 (Version 11.0)

Official Release Version

Friday, September 05, 2025

UPDATE 2

Build: 11.0.2.20905

Requested Enhancements 10/09/2024 - 09/05/2025

Date ImplementedItem Description

11.0.2.20821Release Build:
 

01. 08/06/2025 R:Compiler for R:BASE - The Load Project process was updated with additional validations to load project
files.

02. 08/04/2025 Forms - The MAKECLICK parameter is supported for the Tile Menu control, which specifies to fire the "On
Click" EEP for a tile, simulating a mouse click.

03. 08/01/2025 Forms - When an image is loaded for the Collapse Panel, Enhanced Tab Page, or Glyph Status Pane for
the Status Bar Control, a "Last File Name" path is now provided.

04. 07/08/2025 Form Designer - The Value toolbar has been enhanced to allow editing of table, field, variable, 
and caption values. Up to three properties may be changed at a time, depending on the control. The
toolbar will also expand automatically to fully display a selected item's characters in the toolbar.

05. 07/07/2025 Utilities - The Default Settings Utility was updated to delete .RST files (Find in... search history) in the
user's folder. If the "Create Backup" checkbox is checked, then backup *.~rst files will be created.

06. 07/07/2025 Database Conversion - When converting DOS forms to Windows forms, the default Font Size should be
10. When converting DOS reports to Windows reports, the default font Size should be 11.

07. 07/07/2025 Database Conversion - When converting forms, reports, and labels from legacy releases, the object lists
should be sorted by the Name. Also, users should be able to sort the list view by clicking on the column
title.

08. 07/01/2025 BLOB Editor - There is a Print Setup option within the Image and Rich Text tabs of the BLOB Editor, but
not in the Text tab. Please add a Print Setup option for the Text  tab, especially since a user may hide the
other available tabs.

09. 06/30/2025 Commands - The TITLE portion of the CHOOSE command has been enhanced to support 150 characters.
The prior limit was 75 characters.
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11.0.2.20821Release Build:
 

10. 06/25/2025 Error Messages - The error message for message 2161 has been improved to include the variable name,
for when an unrecognized global variable exists in an expression. The error message for message 2160
has been improved to include the column name, for when an unrecognized column exists in an
expression.

11. 06/16/2025 Utilities - The Quick Prompt is a new utility that can be launched for users to set/query values any place
within R:BASE. The Quick Prompt is basically a floating subset of the R> Prompt. Pressing
Ctrl+Alt+Shift+Q will display the Quick Prompt utility. The Quick Prompt may be of use specifically when
development is taking place within a modal window (Add/Remove Variables, EEP Editor, etc.) and there is
a need perform R> Prompt tasks (SELECT, SET VAR, etc.) without closing windows and losing declared
data/values.

12. 06/13/2025 Forms - Added support for checking multiple items for List View, Variable Lookup List View, and DB
Lookup List View controls where pressing the [Space] key will update the checkbox state of the selection
when there are multiple highlighted items.

11.0.2.20612Release Build:
 

13. 06/10/2025 Settings - A new Soft Touch setting has been implemented for the Database Explorer. When checked, the
Touch function will only update the timestamp of the form/report/label without opening/saving it (and is
therefore much faster). The default is unchecked.

14. 06/05/2025 Database Conversion - The Application/External Form Conversion dialog was improved with an updated
user interface.

15. 06/04/2025 Database Conversion - The Form/Report/Label Conversion dialogs were improved to list the table name
and comment. The user interface was also updated.

16. 06/03/2025 R:BASE Editor - Added ability to save/load an R:BASE Editor session where a list of command files is
opened from a prior session. The session is saved/loaded using a R:BASE Editor Session File (*.rbsf).
Session files may be stored and loaded for application modules, different clients, or to easily continue a
development session. The "Remember Current Session" setting has also been implemented to restores a
group of command files, which were open in the prior R:BASE session. If the manual save/load method is
preferred, the "Remember Current Session" setting should be unchecked.

17. 06/02/2025 Settings - It would be very helpful to have the ability to specify a custom tab/window order for the
Database Explorer, R> Prompt, and R:BASE Editor modules when R:BASE launches. 

The Startup Settings now allow for the window/tab order to be specified. The module listed first will be
assigned the focus.

18. 05/28/2025 Database Explorer - The property bar has been enhanced with an additional information item, where the
number of selected/highlighted objects is displayed.

19. 05/21/2025 Database Explorer - Large/Multi monitors are commonplace allowing us to easily view multiple
simultaneous windows within the Database Explorer.  Please have the various Designers (Forms, Reports,
Labels, External Forms, etc), R> Prompt, Save-Table-Layout and Explorer remember their window size and
position when they are closed - there is no need to open them full screen. When they open full screen
and I always have to resize & locate them.

20. 05/16/2025 Report/Label Designer - Sometimes it can be difficult to remember where a piece of code was added to a
report band when there are several breaks, with report and page headers/footers. It would be helpful if
there was some type of notification upon the report band to let the user know that code exists in the
band, similar to how a Custom EEP button is yellow when code exists.

An icon was added to the left side of the band. If one of the two available band EEPs (Before/After
Generate Custom EEP) have code, then a single tag icon is shown. If both EEPs have code, then an icon
with 2 tags is displayed.
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11.0.2.20612Release Build:
 

21. 04/17/2025 Reports/Labels - The System Variable Control includes "Copy Number" and "Copy Number Description"
as added options for output.

Copy Number - Current copy number (when printing multiple copies to the printer)
Copy Number Description - Textual summary of the current copy number ('Copy 1')

Note: The "Copy" system variable values text will not print with the original document.  The control will
print with the first and subsequent copies of the report/label.

11.0.2.20415Release Build:
 

22. 04/08/2025 Forms - The Tile Menu control and Action Bar tab has been enhanced with "Duplicate" and "Edit Custom
EEP" buttons to easily reuse and modify Action Bar items.

23. 04/02/2025 BLOB Editor - The RBBEDIT command supports editing BLOB data directly from a SELECT query. The
syntax uses the SQL keyword prior to the query syntax.

    RBBEDIT '<SQL SELECT ContPhoto FROM Contact WHERE ContID = 1001>'

24. 03/20/2025 Forms - Using the DB Tree View, it can take time to build the tree when the form is run. It would be nice
to have a hourglass or loading indicator so the user knows the tree is building and the program is not
frozen.

25. 03/13/2025 R:BASE Editor - Added "EEPs" menu bar option when editing Custom EEPs and actions (Custom Form
Actions, On Before Design Action, etc.) where the R:BASE Editor allows the editing/browsing of other
code within the form/report/label without leaving the current editor session. The EEPs menu bar options
allow for nested instances of the editor, where each instance places the control or action description in
the editor's caption bar.

26. 03/05/2025 Commands - The NULLSET command has been implemented to set variable values to NULL for individual
variables, or a variable list. 

    NULLSET VAR vCost, vReportName

    NULLSET VAR vCust%

    NULLSET ALL VAR EXCEPT vOutput

27. 03/05/2025 Utilities - The Scratch Pad tool is not available when reviewing the Form, Report, Label "Find in" search
results. It would be helpful for the Scratch Pad to be available, where the user is not forced to use some
other utility for copy/paste of code/text.

28. 03/05/2025 Menus - Provide the option to toggle between hidden and visible characters when entering a password,
allowing users to preview the input string before submission. This includes any password Dialog box as
well as the R:BASE prompt for a user's database password.

Password edit boxes now have a button on the right side. When clicked, the password is shown on when
the mouse button is clicked down, then hidden again when the mouse button is released.

29. 03/04/2025 Form Designer - A new Value toolbar has been implemented where a control's caption/text can be edited
directly from the toolbar. The Value toolbar is included in the "View > Toolbars" option list.

30. 03/04/2025 Data Dictionary - When using the Data Dictionary in MDI mode, it would be nice to be able to just double
click on the table name, column name, etc. to paste the value.

31. 02/25/2025 Database Explorer - Please implement a way to access and modify EEPs in a form without having to open
the designer.

Within the Forms, Reports, Labels, and External Forms areas, the "EEP Quick Edit" menu option has been
added where the object's EEPs may be reviewed and modified without having to open it in the designer.
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11.0.2.20415Release Build:
 

32. 02/18/2025 Data Browser - The Show Column and Hide Column dialogs have been enhanced with a filter field, where
the column names may be filtered within the list, to quickly locate the desired column.

33. 02/17/2025 Data Designer - A "Find Column" search utility has been implemented within the "Columns" area where a
specific column may be located quickly in a large list of column names. Once the column is selected and
the "OK" button is clicked, the column name will be highlighted. The dialog also provides the column
comments.

34. 02/17/2025 Data Browser - The column name search (Move to) utility has been enhanced so a specific column may be
filtered within a list, to quickly locate the column in a large list of column names. Once the column is
selected and the "OK" button is clicked, the column name will be highlighted. The enhanced "Find
Column (Ctrl+F8)" options (toolbar and menu bar) have also been moved to appropriate locations.

35. 02/17/2025 Database Explorer - The Tables and Views group bar options have been enhanced to include search
utilities to locate column names in tables and views.

36. 02/17/2025 Forms - Auto-Arrange buttons have been implemented to offer a quick and simple method to arrange
the tab order for a group of controls in a container, where the controls' X and Y pixel coordinates ("Top"
and "Left" properties) dictates the tab order. The control locations would only need to be placed in the
desired coordinates needed for the tab focus movement, and the single button would assign the tab
order to either the "Left-Right, Top-Down" or "Top-Down, Left-Right" order.

37. 02/11/2025 Settings - A new NUMROUND setting has been introduced which rounds any excess scale digits for
numeric data types.

The default value is OFF, which means that numeric values must follow the definition for the maximum
number of digits to the right of the decimal (the scale).

If NUMROUND is ON, then as long as the number would round to a valid numeric with that precision and
scale, R:BASE will accept the value. This means that if you entered 0.237 with NUMROUND set to ON, it
will be allowed, and the stored value will be 0.24.

38. 02/04/2025 Database Explorer - An additional unload menu option has been added for views, stored procedures,
forms, reports, and labels where one or more selected item is placed into a separate file.

39. 01/29/2025 Printing Reports/Labels - In R:BASE 11, the Report/Label Designer displays the Preview output in the
center of the screen. In R:BASE 10.5, the Preview output is shown in the top left corner of the screen. The
R:BASE 10.5 behavior is a bug because as soon as the zoom settings are changed or the other predefined
zoom buttons in the toolbar, the report will be rendered in the center of the screen. That left-aligned view
only applies when clicking the 100% button in the toolbar of 10.5 (and prior releases).

However, if you love the classic behavior, implement the following new setting on the application startup:

    PROPERTY REPORT CLASSIC_100PCT_PREVIEW ON

40. 01/29/2025 Settings - A new PARSESEMI setting has been introduced which controls the parsing of semi colon
characters in the processing of ampersand variables. The default value is OFF, which means R:BASE
ignores semi colons in ampersand variables. If PARSESEMI is set to ON, then you can have semi colons
inside an ampersand variable to stack multiple commands.

41. 01/20/2025 Functions - When connected to a database with no User Privileges defined, the TINFO function returns
"SELECT, UPDATE, INSERT, DELETE, ALTER, REFERENCE" permissions even though the USER name does
not exist. The function was enhanced to return a NULL value if there are no users defined.

42. 01/20/2025 In-memory Tables/Commands - The limit on In-memory tables has been increased from 10 to 25.
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11.0.2.20107Release Build:
 

43. 12/18/2024 Commands - Support has been added for temporary tables that are stored in memory, instead of a
temporary file. In memory tables may be created with the CREATE TABLE, INTERSECT, JOIN, PROJECT,
SUBTRACT, and UNION commands. The command syntax allows the INMEMORY keyword to be used
where TEMPORARY is normally located.

    CREATE INMEMORY TABLE NewTable1 +
    (NewColumn1 INTEGER, NewColumn2 TEXT 8)

When such a table is created, nothing is written to the temporary file 2 for the data rows. The table and
rows are in memory. R:BASE initially allocates 32,000 bytes for each INMEMORY table, whereas the table
grows, the space will increase as needed. R:BASE currently limits databases to twenty-five (25)
INMEMORY tables. If any keys are built for an INMEMORY table, the key data will be written to the
temporary file 3. When using the LIST command, INMEMORY tables will have an (I) in front of the name,
instead of (T).

44. 12/16/2024 Functions - The TINFO function has been enhanced to allow the OWNER to specify a USER name for the
first parameter. 

    SET VAR vUserPermission = (TINFO('Mary',41,-1))
    SHOW VAR vUserPermission
    SELECT, UPDATE, INSERT, DELETE, REFERENCE

45. 12/11/2024 Forms - A new column-level SHOWEDITOR property was added to launch the BLOB Editor for a specific
column.

    PROPERTY TABLE_COLUMN[ContactCallNotes->CallNotes] SHOWEDITOR ' '

46. 12/10/2024 Reports/Labels - Image support has been implemented for the Advanced Rich Text control's "Mail
Merge" feature. With the enhancement, VARBIT fields/variables are automatically interpreted as images.
For non-VARBIT fields/variables, the name must be appended with the 'IMAGEFILE' display format. The
'IMAGEFILE' display format is applicable to values containing the path of the image file. 

Mail Merge Example Uses:

<ContPhoto>
<ContLName>, <ContFName>

<ContPhotoPath|IMAGEFILE>
<ContLName>, <ContFName>

{ContPhotoVarBit}
<ContLName>, <ContFName>

{ContPhotoPath|IMAGEFILE}
<ContLName>, <ContFName>

47. 12/05/2024 Forms - The DB Tree List was enhanced with additional properties for selecting a specific node. The
TOPNODE property sets the topmost node passing the node's key value. If the value is empty, the very
first node in the tree is used. The SELECTNODEBYID property sets the selected node by an ID value.

     PROPERTY DBTreeList TOPNODE ' '
     PROPERTY DBTreeList SELECTNODEBYID 'Value'
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11.0.2.20107Release Build:
 

48. 12/05/2024 Forms - Sub-directory support was added to the File List Box control, where it is possible to view and
traverse sub-directories when listing files in the File List Box. The control also was updated to provide a '..'
entry within the list box, to move one directory up. To enable such, the Object Inspector may be used to
alter the  properties. However, the property editor did not have an option to enable Directories in the list
box. 

The File List Box was enhanced to provide a File Type option with file type attributes to include/exclude
from the list box: Read Only, Hidden, System Directory, Archive, Normal. The below FILETYPE properties
may also be added/removed within the property set, using the following syntax:

    PROPERTY RBFileBox1 FILETYPE '+DIRECTORY'
    PROPERTY RBFileBox1 FILETYPE '+NORMAL'
    PROPERTY RBFileBox1 FILETYPE '+READONLY'
    PROPERTY RBFileBox1 FILETYPE '-HIDDEN'
    PROPERTY RBFileBox1 FILETYPE '-ARCHIVE'
    PROPERTY RBFileBox1 FILETYPE '-SYSTEM'

49. 12/04/2024 Data Browser - In View as Grid mode, highlighting a cell should also highlight its entire row, as is already
done with the View as Tree Grid mode. This is especially important when there are too many columns to
display without scrolling horizontally, or when using an ultrawide monitor where the small black triangle
to the right of the row number is not directly in view.

50. 11/20/2024 Utilities - In the color/font color editor, pressing the [F6] key will switch the hex entry textbox between
Delphi style RGB ($) and HTML style RGB (#). The utility makes it easier to use colors from online sources
(which are mostly HTML style RGB).

51. 11/12/2024 Forms - Added form-level ENABLEDATASETSCROLL property to disable processing when the dataset is
scrolled. An example is when a dataset is loaded in a grid, where partial or all rows in the dataset are
traversed. During the traversal, there are processes performed for each dataset row to synchronize things
(e.g. variables, control states, etc.).

If EnableDatasetScroll is FALSE, these processes are not performed, making faster response times. The
feature is particularly useful in grid-like controls where multiple rows are loaded. The default value is
TRUE.

    PROPERTY RBASE_FORM EnableDatasetScroll 'FALSE'

52. 10/30/2024 Forms - The File List Box control was enhanced to optionally include the file Size, Creation Time, Last
Access Time, and Last Write Time values.

53. 10/10/2024 Data Dictionary - The utility was enhanced with an incremental search feature for the list view display
mode. While focused on a list view, pressing the [/] key will show the Find dialog. Typing into the entry
box will auto-locate a match. Note that the incremental search feature only works when the [/] key is
pressed, and not when [Ctrl+N] is pressed.

54. 10/09/2024 Data Dictionary - Optimizations have been implemented when loading the Data Dictionary, which will
open faster than prior builds.

Page 6 of 17

Copyright © 1982-2025 R:BASE Technologies, Inc. All Rights Reserved.



Reported Bug Fixes 10/09/2024 - 09/05/2025

Date FixedItem Description

11.0.2.20905Release Build:
 

01. 09/03/2025 Forms - The DB Label object does not display with the expected database CURRENCY format.

02. 09/03/2025 Commands - The DIALOG command's BUTTON_OK_WIDTH and BUTTON_CANCEL_WIDTH parameters do
not work as expected, where the button widths are not increased.

03. 08/30/2025 ODBC - When opening an ODBC-attached table with image data in the Data Browser, the image does not
display as expected.

11.0.2.20821Release Build:
 

04. 08/14/2025 Commands - When using the TOP and LEFT parameters to display a DIALOG window at a screen location,
the window only appears in the top left corner of the monitor.

05. 08/14/2025 Commands - When updating the CHECKED value for a DB Radio Group with the PROPERTY command,
the button is not checked.

06. 08/01/2025 Forms - When an image is loaded for the Custom Wallpaper control the Last File Name path is not loaded
with the image folder and name.

07. 08/01/2025 Form Designer - When an image is loaded into an Image control, the "Last File Name" is populated with
the path and image. However, when the mouse cursor hovers over a long string and truncated path, the
full value is not displayed as a hint. 

All form controls which support loading an image were also updated to display the path hint.

08. 07/31/2025 Reports/Labels - When printing a report to a PDF file where text is defined as italicized, the text does not
display as such in the output.

09. 07/25/2025 Reports/Labels - When assigning a value to a Component ID a letter case verification is incorrectly case
insensitive. The logic was updated to perform a case sensitive check.

10. 07/24/2025 Reports/Labels - When printing a report to a PDF file where control properties have invalid or empty
URLs, issues may occur to create the output file.

11. 07/18/2025 Forms - When many tabs are defined for an Enhanced Tab Control, and the Object List toolbar is used to
display the tabs and open the Property Editor, the External Form/Form Properties dialog opens rather
than the expected Enhanced Tab Page properties.

12. 07/18/2025 R:BASE Editor - When modifying code in the EEP Editor, clicking the [Apply] button applies the changes
and saves the EEP. Both [Apply] and [OK] buttons are then disabled. Only the [Apply] button should be
disabled as there are no further changes to be applied. The [OK] button should not be disabled, as this
button also serves as the confirmation when everything is [OK] to close the EEP editor. Having just the
[Cancel] button gives the wrong impression to press [Cancel] to close the EEP editor.

13. 07/16/2025 File Gateway - When attempting to import a XLSX file into a new temporary table R:BASE stops
responding when the "Start" button is clicked. The Sheet, Fields, etc. dialog does not appear.

14. 07/16/2025 Report/Label Designer - When using the Rich Edit control, the "Insert Field" and "Insert Variable Label"
options do not display the field/variable lists to choose from.

15. 07/10/2025 R:BASE Editor - When altering multiple Comments styles in the Scheme Editor, the expected font options
popup no longer appears after saving a revised multi-line comment.
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11.0.2.20821Release Build:
 

16. 07/02/2025 R> Prompt - The [Ctrl+F] utility to search the Output Console may not function as expected if prior search
history aspects are retained.

17. 07/02/2025 Database Explorer - When opening the Find in Files utility from the Database Explorer, using [Ctrl+F], and
performing a search for text, after closing and reopening the utility, the prior search criteria may not be
not listed in the "Find Text" drop-down if prior search history aspects are retained.

18. 07/01/2025 Menus - When using the R:DCC a blinking/flashing behavior is noticed when the mouse cursor hovers
over the menus.

19. 07/01/2025 Reports/Labels - When printing a report to a PDF file from the Print Preview, the Break Header 0 
calculation is incorrect.

20. 06/30/2025 Forms - When filtering DATE data type columns in an Enhanced DB Grid error messages are encountered.

21. 06/24/2025 Functions - When using the ITEMCNT function on a VARCHAR variable with a NULL value, the command
file in use stops processing but remains locked.

22. 06/23/2025 Forms - When using a Group Bar control with various image sizes, the spacing between the group items
is not maintained. In prior versions the spacing between the images is preserved and the images do not
overlap.

An "Item Height" property was added to the Group control object. The default value is 20.

11.0.2.20612Release Build:
 

23. 06/09/2025 Forms - The Variable Date and Time Edit control will incorrectly revert to, and display at, the default
height of its drop-down glyph font.

An "Auto Size" property has been added to the property editor dialog. The setting is enabled by default.
To address the auto size issues, the setting should be unchecked.

24. 06/09/2025 Runtime for R:BASE - When attempting to print a report in Runtime for R:BASE 11, the report does not
display to the screen or the printer.

25. 06/09/2025 Commands - When EEP-monitoring has been enabled with the TRACE_LAST_EXEC_EEP, TRACE_ALL_EEP,
and LOG_EXEC_EEP parameters enabled, the resulting trace messages indicate that the EEPs (though
empty) are being processed out of order.

26. 06/06/2025 R:BASE Editor - The Structure toolbar does not display instances of (at least) the CASE command or the
ENDIF command. Newer v11-specific commands (RESET, SET STATICVAR, EXPLAIN, DBCONN, and
NULLSET) were also added.

27. 06/05/2025 R:BASE Editor - The "Always Refresh Structure" setting refreshes the Structure toolbar when switching
between open files and when the file is saved, but also performs the task when the toolbar is not visible.

28. 06/04/2025 Commands - Using the NULLSET command in a form EEP results in the "Illegal command in Enter/Exit
Procedure" error.

29. 06/02/2025 File Gateway - When the Export Wizard is used to save a specification file, where a change in export must
be saved to the existing RGW file, an invalid file name is listed in the dialog when the "Save To Selected"
button is selected.

30. 06/02/2025 R:BASE Editor - When a Custom EEP is being edited from within the Form Designer, fewer menu items are
displayed as compared to directly editing a command file with the Editor.

31. 06/02/2025 Settings - If FEEDBACK is set ON when clicking "Test Clause" in the WHERE Builder with an ORDER BY
defined, the "Sorting complete..." Feedback message lists the incorrect table in the dialog.
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11.0.2.20612Release Build:
 

32. 06/02/2025 File Gateway - When exporting a table in the File Gateway Export Wizard, the interface forces the
resulting filename to upper case letters.

33. 06/02/2025 File Gateway - When exporting a table in .XLSX format, the Export Wizard keeps reselecting the "Add a
blank row after field names" check box for a defined Specification File" even when it has been manually
unchecked and saved for the RGW file.

34. 06/02/2025 File Gateway - When browsing for a CSV file using the Import Wizard with Format Type Text file (*.txt,
*.csv, *.dat, *.asc, *.prn, *.tab), no .csv files are displayed by default, only .txt files.

35. 05/28/2025 Data Browser - In View as Tree Grid mode, sorting a TEXT field sorts upper case values before lower case
values (e.g., "FO" sorts before "Fa").

36. 05/28/2025 Data Dictionary - The BOOLEAN, NAME, STARTUP, and UINOTIF settings are not listed in the Database
Settings tab.

37. 05/28/2025 Data Browser - When a BROWSE command is used to invoke the Data Browser for a non-editable (multi-
table) view, double-clicking on a cell in a NOTE column nevertheless displays a "Switch To Edit Mode"
button in the BLOB Editor.

38. 05/27/2025 Form Designer - When a control without caption is copied/pasted, the control is incorrectly assigned an
auto-generated caption.

39. 05/27/2025 Forms Designer - Could the open dialog (Ctrl+O) list the objects in the same order as they are displayed
in the Database Explorer, (i.e. sorted by name, date, etc.) as was done in version X.5?

40. 05/27/2025 Report Designer - The window location and size of the Breaks dialog is not persisted between sessions.

41. 05/21/2025 Database Explorer - When making a copy of a Form (Copy Form), copy of a Report (Copy Report), copy of
a Label (Copy Label), or a copy of any module of the Database Explorer, on any edit boxes to type,
pressing F3  for the Data Dictionary does not work.

42. 05/19/2025 Form Designer - After selecting to duplicate a Custom Form Action, the new action Name and Description
is not editable. The Action Designer must be closed and reopened in order to change the duplicate
action.

43. 05/16/2025 Commands - If a table includes a column whose foreign key references the primary key column in the
same table, then an attempt to use the DROP command to drop that table displays the message "-
ERROR- This table is referenced by a Foreign Key - unable to drop table. (2720)". In this case, the DROP
command should be honored, since the offending key constraint will automatically disappear along with
the table (assuming no other table references the one being dropped).

44. 05/16/2025 Commands - The LIST TABLE command does not display the "Next Value" and "Increment by" for
autonumbered columns in temporary/in-memory tables, as R:BASE does for permanent tables.

45. 05/16/2025 Utilities - A focus rectangle has been implemented on the Color Editor tiles to make the selection more
obvious.

46. 05/16/2025 Settings - If ECHO is set ON when a RENAME command is used to rename a table, several internally
generated commands are displayed. If ECHO is set ON when a RENAME command is used to rename a
column, the scratch file is listed.

47. 05/16/2025 Commands - When using the SHOW VARIABLE command with a wildcard and also with a larger
NAMEWIDTH setting value the variable values do not line up in the output.

48. 05/16/2025 Commands - The RENAME COLUMN command does not detect the case of the old and new column
names being identical. This is most likely to occur as a result of a mistyped command involving similarly
named columns.
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11.0.2.20612Release Build:
 

49. 05/16/2025 Messages/Error Messages - During program startup, if an error is detected in RBENGINE11.CFG (e.g., an
invalid setting) and the splash screen is set to be displayed, then the popup containing the associated
error message is overlaid by the splash screen, and neither one can be selected or dismissed using
ordinary mouse clicks. (The contents of the error popup can be visualized, but not selected, by hovering
the mouse cursor over the popup's Taskbar icon.) Ultimately, R:BASE must be terminated via the Task
Manager.

50. 05/16/2025 Commands - If a database has been opened in read-only mode, the UNLOAD STRUCTURE command
produces the error: "-INTERNAL ERROR- Out of dynamic space"

51. 05/16/2025 Commands - The command "CHOOSE varname FROM #TBLVIEWS" displays a popup titled "Choose a
table" rather than "Choose a table or view".

52. 05/15/2025 Settings - In the R> Prompt Settings, the Color settings within the Default Font selection panel for both
the Input Console and the Output Console have no effect; they are overridden by the Font color settings
for the corresponding Console.

53. 05/15/2025 R> Prompt - The Command History does not consistently preserve the case of a command typed into the
Input Console; the saved casing may depend on whether the command has an earlier entry in Command
History with different casing.

54. 05/15/2025 Reports/Labels - When printing note fields to PDF files the spacing between characters is different, and
the spacing between lines is also different.

55. 05/14/2025 User Privileges - When reviewing the User Privileges, the views are not displayed.

56. 05/14/2025 Database Conversion - When converting legacy version 6.5++ for Windows reports, the option to convert
double quotes (") to single quotes (') in report variables does not convert the quote characters.

57. 05/13/2025 Forms - The R:BASE Editor (for EEPS) "Apply" button is not displayed if a Custom Form Action is chosen
from within the "Layout > Custom Form Actions > Action Designer > Edit Command" menu option
sequence. 

58. 05/13/2025 Reports/Labels - Both static text and DB value text repeat in the PDF output with an Advanced Rich Text
control.

59. 05/12/2025 Reports/Labels - The arrow character with the Wingding font does not render as expected in Web
browsers as the PDF reader, unlike prior versions.

60. 05/12/2025 ODBC - After a Server table is dropped from a database, the comment is not removed from the
SYS_COMMENTS table.

61. 05/08/2025 Report/Label Designer - When selecting fields in the Edit toolbar, the walkmenu feature, to have the focus
move to values for typed keys, is no longer working.

62. 05/08/2025 Database Explorer - The mouse cursor hint no longer appears above the database cylinder and Favorite
Folders items on the status bar and property bar.

63. 05/06/2025 Commands - After a SUBTRACT command is used to create a table the comment is incorrectly pulled
from the last comment in the SYS_COMMENTS table.

64. 05/02/2025 User Privileges - Based upon how an OWNER name is submitted for a password-protected database, a
view may not be recognized as defined when opening a report in the designer.

65. 05/01/2025 Reports/Labels - The appearance of bold text on PDF reports is different in version 11.0 versus version
X.5.

66. 05/01/2025 Forms - The non-selected tab stubs are different/lighter colors in version 11, wherein version X.5 the Tab
Pages are static colors, always matching the color of the full tab.
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67. 05/01/2025 Forms - When displayed in a grid control, long text strings are cutoff differently, where the result is that it
becomes less obvious that the user needs to click the description to see entire value.

68. 05/01/2025 R:BASE Editor - When R:Style processes a CHOOSE command containing the WINDOW_CAPTION SMALL
parameter, it replaces SMALL with SMALLINT.

69. 05/01/2025 Forms - The whole column in the scrolling region changes color when the cursor is placed in it, rather
than only the selected field.

70. 04/30/2025 Forms - The Enhanced DB Grid column headers are a different color in version 11.0 versus version X.5.

71. 04/30/2025 Plugins - When using the SysDialog plugin (or builder) and implementing the "Confirmation" icon, it is
the same image as the "Information" icon. There used to be a question mark icon for the Confirmation
message box.

72. 04/30/2025 Forms - There is a frame automatically added around the options for all the Radio Button Groups. The
frame appears to be theme-related.

73. 04/30/2025 Forms - Only the overall radio group hint is displayed when the mouse cursor is hovered over the control,
not the individual option hints.

74. 04/30/2025 R:BASE Editor - If a QUIT command is executed as part of a series of highlighted commands with Run
Selection (Ctrl-F8) from within the Editor, the "Illegal command in Entry/Exit Procedure" message is
issued.

75. 04/30/2025 Forms - When displayed, popup menus no longer have the same theme as the parent form.

76. 04/30/2025 R:BASE Editor - In the Print Selection dialog, the Help button has no effect.

77. 04/29/2025 R> Prompt - The Find in R> Prompt Output may report false hits when just a prefix of the Search Text
matches, though the entire Search Text does not match. This behavior only occurs when searching in the
Backward direction.

78. 04/29/2025 Database Explorer - After a table is unloaded to a file, the file does not appear at the top of the
Command Files list when the Date/Time is sorted in descending order. The Date/Time header may be
clicked twice, to sort ascending and then descending, but the new file is still not listed. The user must
scroll to see the new file.

79. 04/29/2025 BLOB Editor - The "View > Calculate Image Colors" popup displays a typo: "The active images has ..."

80. 04/29/2025 Settings - In the Default Form Settings > Form > Default Size, the "Auto Scroll" setting would be more
informative as "Auto Scrollbars"

81. 04/29/2025 Forms - When a DB Edit control is assigned to a NOTE data type column the information no longer
displays when running the form.

82. 04/29/2025 R> Prompt - The Find in R> Prompt Output search history is not cleared by pressing Ctrl-R, as is
documented in the Help.

83. 04/29/2025 Commands - The EEP trace log produced by "PROPERTY APPLICATION LOG_EXEC_EEP ON" should prefix
all lines with "[EXEC EEP <DateTime>]" so that they can be quickly recognized by eye or by a filtering
program, but it does not.

84. 04/29/2025 Commands - For the DIALOG command, if enclosing quotes are used to supply a literal text value to the
BUTTON_YES_CAPTION, BUTTON_NO_CAPTION, BUTTON_OK_CAPTION or BUTTON_CANCEL_CAPTION
options, those quote characters themselves become visible within the buttons. The circumvention,
omitting the quotes, is not always satisfactory because R:Style may change the casing and display-style of
the unquoted text.
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85. 04/29/2025 Database Explorer - When R:BASE is open in an RDP session there are white/blank areas displayed, rather
than the expected background color.

86. 04/28/2025 Form Designer - The "Apply" button is missing from the Enhanced DB Grid property editor dialog.

87. 04/28/2025 R> Prompt - If the main R> Prompt tab is (inadvertently) closed (by clicking on the "x" within its tab) and
then reopened, subsequent command output is no longer spooled to the Output Console; R:BASE
behaves as though output had been redirected elsewhere, but OUTPUT SCREEN does not restore normal
behavior.

88. 04/28/2025 Settings - In the R> Prompt Settings for the Input Console, the selected Background color takes effect as
expected, but is incorrectly labeled in both the current color field and in the color-list dropdown.

89. 04/28/2025 Settings - When "Allow Only One Instance of R:BASE" is checked and a second instance is attempted, the
initial instance should be assigned focus and/or maximized.

90. 04/24/2025 Forms - When using the DROPROWS parameter for the PROPERTY command for the DB/Variable
Date/Time Picker control, the calendar does not display as expected when the drop rows value is set to 2.

91. 04/24/2025 Plugins - When using the LoadDirectoryName plugin and assigning custom captions for the button text,
the custom text values are ignored.

92. 04/24/2025 Database Explorer - After dragging a RDP session window to the primary monitor and then back to a
secondary monitor the "Current folder" text is black and no longer legible.

93. 04/24/2025 Forms - When using the Directory Tree control, there is an odd paper icon and ".." path listing for
all folders, which appears to mirror the contents of the initial folder path.

94. 04/22/2025 Database Explorer - An exception error may occur when deleting objects.

95. 04/22/2025 Form Designer - After creating a new form and the designer is displayed, the newly created form is in the
Open Form (Ctrl+O) list, but it is incorrectly at the bottom, and not arranged alphabetically.

96. 04/22/2025 R:BASE Editor - When opening a file, and the "Objects of type" field keeps reverting to XML, rather than
"R:BASE" files, when switching between R:BASE 11 and R:BASE Editor 11.

97. 04/22/2025 Forms - When using an Image control, the CopyToClipboard PROPERTY command parameter does not
capture the image to the clipboard as expected.

98. 04/21/2025 BLOB Editor - When using the "Text" tab, clicking on the Search button or pressing the [Shift+F8] key
combination displays the Find Text dialog. However, the Windows standard [Ctrl+F] key combination
does not display the same Find Text dialog.

99. 04/21/2025 Form/Report/Label Designer - While focusing and placing the cursor in the Value toolbar, [Ctrl+A] does
not select the entire text.

100. 04/16/2025 Commands - When using the SHARECPY command with a wildcard the resulting file names are truncated
to eight characters.

11.0.2.20415Release Build:
 

101. 04/11/2025 Forms - When initiating a drag and drop operation with the first level node of a DB Tree List control an
error is encountered.

102. 04/10/2025 Form Designer - When floating, the Control Palette toolbar width can be decreased to almost nothing
and increased to as far as the monitor display allows.

103. 04/09/2025 Form Designer - The Control Palette is assigned a default height value that is not large enough for the
initial display.
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104. 04/08/2025 R:BASE Editor - When a command file is open in R:BASE Editor, and the Find in Files utility is opened from
the "Utilities > Find in Files" option, when a Ctrl+V paste operation is made, the clipboard contents
incorrectly appear in the command file, and not the focused field in the Find in Files dialog.

105. 04/08/2025 File Gateway - When an exception file is specified with the GATEWAY syntax (ERROR_FILE exception.log), 
not all errors are logged within the file for why the data is not inserted.

106. 04/07/2025 R:BASE Editor - When performing search and replace operations for a single command file, any
subsequent search and replace operations after the first does not work, where the values selected in the
drop-downs are not recognized.

107. 04/07/2025 File Gateway - When importing data from an HTML file, not all records are brought into the table when
compared with prior versions. The difference is with INTEGER columns, where when a value does not
meet the data type requirements, the  entire row is not loaded. In prior releases only that value is not
loaded into the table.

108. 04/04/2025 Report Designer - When objects are defined outside of the report margins and the red notification lines
appear to note the object's invalid placement, the red lines do not adjust when the designer is zoomed
in/out.

109. 04/04/2025 Reports - When printing a report with a CrossTab control, there is a large amount of space across the
lower end of page 1 for the report. On the report's 2nd page, the remaining portion of the CrossTab is
printed, which can fit on Page 1.

110. 04/04/2025 Reports - When altering the CrossTab Title value, the header of the tabulated column is not saved
permanently.

111. 04/03/2025 Reports/Labels - When a system variable object is defined as a Date value for a report/label, the display
format does not follow the database's date format.

112. 04/02/2025 Report Designer - When designing a report and adding a JPG image with the transparent setting applied,
there is a noticeable delay when selecting different objects on the report. If the image type is changed to
a PNG file, the Report Designer is back to the normal response when the objects are highlighted.

113. 04/01/2025 Data Designer - When defining a default value for a column, where the value contains higher ASCII
characters, the displayed value is incorrect.

114. 03/25/2025 Commands - When creating an in-memory table with a PROJECT command including an ORDER BY, the 
initial allocated memory is less that what is required for the sort.

115. 03/20/2025 Forms - Using a DB Tree View with a search utility on the bottom of the form works correctly, but
sometimes when the FINDNEXTNODE command runs, it does not show the node on the screen. The user
must scroll down to see it.

116. 03/17/2025 Report/Label Designer - When initially opening a report or label in the designer and opening either "Find
in Custom EEPs" or "Find in Control Properties" menu (or hot keys Ctrl+F/Ctrl+L), the search dialog does
appear. Only after an object is selected and unselected does either utility appear.

117. 03/14/2025 Error Messages - If an attempt to connect to a password protected database, with no PUBLIC account, is
left at error message 2318, the database is in a state where no user can connect to it.

118. 03/13/2025 Form Designer - When Undo is used for a Split View control change the form clears to an empty white
background.

119. 03/12/2025 Forms- When a form contains a Tab Control object, each time the R:BASE display is switched to another
module (R> Prompt, R:BASE Editor, etc.) and then back to the form, the form incorrectly lowers/scrolls
down.
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120. 03/12/2025 External Forms - When opening an EEP from an External Form, the EEP Editor does not display. R:BASE
may also close unexpectedly.

121. 03/12/2025 Forms - When the Object List toolbar is floating and the Parented List button is clicked, the toolbar
disappears.

122. 03/11/2025 Reports/Labels - When printing a report to a PDF file, a Variable Label's text is no longer truncated where
the characters overflow into other labels and off the page.

123. 03/11/2025 Forms - When designing a form, several objects will disappear when editing an EEP and using the Data
Dictionary. The Data Dictionary must be opened in the EEP with the Form Component IDs tab as the
default, with MDI set to ON.

124. 03/10/2025 Reports/Labels - Variables are calculated incorrectly when a report is set to Two Pass.

125. 03/07/2025 Data Browser - When a table is opened in the Data Browser and various columns are sorted, Edit Mode
incorrectly becomes disabled.

126. 03/07/2025 Commands - When using the GETPROPERTY RBASE_FORM WINDOW_STATE 'vState' command to capture
the window state, the value of "maximized" is not captured when in NATIVE_FORMS OFF mode.

127. 03/05/2025 Forms - When a PDF Viewer control is placed inside of an Enhanced Tab control, the PDF Viewer displays
outside of the tab control when the form is run.

128. 03/04/2025 External Form Designer - There is a background color difference between the Form Designer and External
Form Designer toolbars when the toolbars are floating.

129. 02/27/2025 Form Designer - A form cannot be modified and saved if the rbase.sch scheme file is not found.

130. 02/26/2025 Database Explorer - When running forms or printing reports/labels and opening the WHERE History, the
initial focus is no longer on the WHERE History items but is on the Search field. Functionality was also
added to allow pressing the down arrow key from the Search edit box to automatically move the focus to
the History Items list box, allowing the scroll-based selection.

131. 02/26/2025 Report/Label Designer - When a new text Label object is added to a report/label, selection of the
characters within the Edit field is not immediately possible.

132. 02/21/2025 Forms - When a Variable Date and Time Edit control is set with the size as locked, the control
automatically resizes to the default width when the form is run.

133. 02/21/2025 Forms - When a control's size is locked, right click and select "Lock Size" from the popup menu, the form
is not dirty. Some other change is required in order to save the form.

134. 02/20/2025 Data Designer - When reviewing column names and after clicking on several names down the list, the
default value will incorrectly appear as the column name when the mouse button is clicked and held
down in the white space.

135. 02/13/2025 Commands - When a multiple columns index includes several NOTE data type columns, R:BASE was not
properly incrementing the pointer to the next comparison value, which made the comparison with the
integer graduation value does not look at the correct location.

136. 02/13/2025 Forms - When dragging an item in the Tab Order list, the items are incorrectly swapped (drag item and
dragged destination), instead of moving the dragged item to the new location and pushing the rest of
the items.

137. 02/11/2025 Data Designer - When text is incorrectly assigned as the default value for an integer column, no error is
detected when saving the table.
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138. 02/10/2025 Labels - When UINOTIF is set to OFF and after a new label is created, an error appears stating the label
does not exist.

139. 02/10/2025 Forms - When UINOTIF is set to OFF and after the Form Wizard is used to create a new form, an error
appears stating the form does not exist. The error may also appear after creating a new form without the
wizard, and a command is used referencing the form (FORMS, EDIT USING, etc.)

140. 01/30/2025 Forms - When custom colors are assigned to the selected row of an Enhanced DB Grid, the text values for
some column cells are not visible.

141. 01/23/2025 R:BASE Editor - When a file is open in the editor and the Structure toolbar is displayed to see the
command names in the file, a save of the file refreshes the toolbar where all assigned commands are no
longer listed.

142. 01/20/2025 Commands - When adding an index to an INMEMORY table errors can be encountered based upon the
SCRATCH file path.

143. 01/17/2025 Reports/Labels - When changing an PDF Annotation control type to Note, it reverts to Comment after the
report is closed and reopened.

144. 01/17/2025 Reports/Labels - When specifying an EMF image file within the Advanced Rich Text control, the image
does not fit within the control's borders.

145. 01/17/2025 Reports/Labels - When selecting "Format > Fill Color" for a table cell, the cell is not filled completely.

146. 01/15/2025 Reports/Labels - When Mail Merge is enabled, right clicking within the Advanced Rich Text Editor lists the
"Insert" options for DB/Variables Labels twice.

147. 01/14/2025 Reports/Labels - After altering the PDF Annotation's Contents value, the report does not become dirty.

148. 01/14/2025 Reports/Labels - The PDF Annotation > Subject does not display the variable value when a variable is
defined for the Subject.

149. 01/14/2025 Data Browser - When hiding columns in the Data Browser and then printing the data, the hidden columns
appear to be mushed together where they are located in the table.

150. 01/10/2025 Report/Label Designer - When toggling the Mail Merge option for the Advanced Rich Text control, the
report does not become dirty.

151. 01/10/2025 Forms - When a list view is sorted by date, selecting an item reorders the records within each date.

11.0.2.20107Release Build:
 

152. 12/17/2024 Forms - When altering the data in an Enhanced DB Grid, the font in use when editing is very small, which
differs from the behavior in prior versions.

153. 12/11/2024 Forms - After adding a column to an Enhanced DB Grid and moving that column up the column list in the
grid before a column with Predefined Values, the list of Predefined Values had their list incorrectly moved
one another column (to the left).

154. 12/09/2024 Commands - When updating VARCHAR column data from a VARCHAR variable, which is populated from
a table SELECT, the resulting updated data is lost.

155. 12/06/2024 Data Designer - When a table is switched to be temporary in the Tables section of the Data Designer, the
text for the "Temporary Table" check box changes to look odd after the warning message is confirmed,
and the box is unchecked.

156. 12/06/2024 R:BASE Editor - When R:Style is run for a command file residing in a long path and file name, the file path
string in the status dialog is truncated.
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157. 12/06/2024 Printing Reports/Labels - The FIND_TEXT_IN_PREVIEW PROPERTY command parameter does not hide the
display of the "Find Text" button before the output is printed.

    PROPERTY REPORT FIND_TEXT_IN_PREVIEW 'OFF'

158. 12/06/2024 Report/Label Designer - When the Edit toolbar is docked to the left or right side of the designer, and
various object types are selected, the toolbar displays odd text on the toolbar.

159. 12/05/2024 Forms - A form fails to open when a File List Box control's default directory is defined incorrectly. The
form opens in prior releases.

160. 12/05/2024 Commands - When comparing a VARCHAR variable to a text value in IF and WHILE commands R:BASE
can close abruptly.

161. 12/04/2024 Commands - When a long VARCHAR was used to update a value and its length was over 40,000
characters, the variable name was stored, not the value.

162. 11/20/2024 Forms - When an Enhanced DB Grid has an expression defined for a column, where the expression is
based upon a table which has a table comment, the table comment is incorrectly being evaluated in the
query string.

163. 11/20/2024 Expression Builder - R:BASE does not catch and display an error when a variable comment is defined in
the Expression Builder with unbalanced braces.

164. 11/11/2024 Commands - When using the IsPortOpen GETPROPERTY parameter the return value is blank.

165. 11/07/2024 File Gateway - When a Specification File is in use within the File Gateway utility, the file name is displayed
in the bottom left corner but is trimmed across the bottom where the characters are not 100% visible.

166. 11/06/2024 Form Designer - When resizing form objects, the width and/or height coordinates appear as a hint once a
handlebar is selected and changed, as the mouse  is dragged. The coordinate hint flickers as the object is
resized. Please remedy the flickering behavior.

167. 11/06/2024 File Gateway - When saving changes to an existing File Gateway specification file, the file name field is
filled with non-English characters.

168. 11/05/2024 Database Explorer - When searching for text in rich text controls (not Advanced) for reports/labels, the
results do not include the expected objects when "Whole Word" is enabled as a search option.

169. 10/29/2024 Error Messages - When an empty file is used with the LOAD command, the returned error reports the file
is not found.

170. 10/29/2024 Forms/Reports/Labels - When selecting to copy/paste variables in the Expression Builder, the paste
operation places the name, data type, expression, and table incorrectly.

171. 10/29/2024 Error Messages - When a LOAD command is successfully used for adding data from a file, and then later
when the LOAD is used again but when the prior path has been deleted, the "File not found" error
message displays odd characters for the now invalid path.

172. 10/28/2024 Reports/Labels - When a transparent PNG is defined for a DB Image object on a report, the image does
not appear in the expected location on the PDF output when it is placed on top of an Advanced Rich Text
label.

Important: When opening a report with image-type objects overlaying Advanced Rich Text in the Report
Designer, the images may be misaligned. If so, those image objects must be repositioned due to the
rendering correction of the Advanced Rich Text object, to match the final output.

173. 10/25/2024 Commands - After the RBSYNC command is used to recreate the .RX3 index file, a lock is placed on the
newly created file which prevents connecting to the database.
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174. 10/24/2024 Reports/Labels - When an Advanced Rich Text label is defined with a bullet list, the bullets do not display
in the Report Designer. When the report is previewed, printed, or opened in the Advanced Rich Text
Editor, the list is visible.

175. 10/24/2024 Data Designer - The Description text within the "Columns" group is no longer wrapped.

176. 10/22/2024 Forms - When a DB Edit control is defined with a format mask, the mask characters do not display when
the form is run in Edit mode unless the focus is on the control.

177. 10/22/2024 Commands - When executing a VARCHAR data type ampersand variable in a WHILE the command is not
recognized. Outside of the WHILE loop, the ampersand variable execution works as expected.

178. 10/22/2024 Forms - Using a Variable Edit control to display the Cue Banner feature, the hint does not appear using
the property editor settings. Only using the PROPERTY
 command does the banner appear.

179. 10/21/2024 Reports/Labels - When the Auto Display setting is enabled for a DB Image object, the setting incorrectly
controls if the image appears when running the report. The setting should only affect visibility during
design time.

180. 10/17/2024 Database Explorer - With the Command Files sorted by date in descending order, after a file is modified,
and the Database Explorer is viewed, the newly saved file is not visible, and is just above the viewed list.
The display must be scrolled to see the newly saved file.

181. 10/16/2024 R:BASE Editor - When the "Create Backup Files" setting is enabled, the backup file is incorrectly created
with the tilde in place of the period. Also, the backup file name was updated to insert the tilde after the
period, and to retain the entire file extension.

182. 10/16/2024 Database Explorer - Under the Command Files, the "Browse..." menu option, which was in version X.5, is
missing from R:BASE 11.

183. 10/15/2024 Data Browser - When selecting "Replace All Column Values" for DATE, CURRENCY, and perhaps other
data types, you can no longer have the values replaced.

184. 10/15/2024 R:BASE Editor - When opening a file within the editor, the available file list within the "Objects of Type"
menu had a "All Files (*.*)" option in prior releases, to open any file type.

185. 10/15/2024 Error Message/Reason - When passing too many characters or items in a command, the error states
"10,000 characters or 400 items", but the reason states "5,000 characters or 400 items".

186. 10/15/2024 Functions - A view created with a LISTOF (DISTINCT ColName) function opens with "New Value Will be
Truncated" warning messages.

187. 10/15/2024 Functions - When creating a temporary view with LIST, rather than the correct function LISTOF, the "Error
in FUNCTION RBListOfTables" error appears when viewing the tables and views at the Database Explorer.

188. 10/14/2024 Forms - When a Group Bar is located within an Enhanced Tab Control, the group bar images do not
display.

189. 10/10/2024 Form Designer - Flickering on image objects may appear when dragging and dropping objects on a form.
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